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You know you’re really old if you remember the paper spread-
sheets that companies used to use to do their number crunching. 
The look of Microsoft Excel resembles those abacuses of papy-

rus, but the advantages to using Excel are numerous, not to mention obvious. You don’t have 
to be a mathematician or have an accountant’s brain to use it. Excel does most of the hard stuff 
for you. I always tell my students that I don’t know that much about math, but I do know how 
to use Excel. The reason I learned Excel in the first place was because I needed a program that 
could do what I was always paying accountants to do.

In this chapter you will learn the fundamentals of how to get around in an Excel workbook, 
add data in the correct places, and make simple changes to the data, as well as how to identify 
and modify the layout components and understand the basic workbook structure. To help you 
master the MOS objectives relating to cell and workbook navigation and organization, I’ve 
provided files on the website for this book that you will need for each exercise in this chapter. 
Download the file named exl2003ch01.zip and extract the files before you begin. 

Throughout these lessons, you will create, and edit, and save workbooks. To keep the lessons 
well organized, I recommend that you create folders and subfolders to hold all the files you 
save. Though you can do this from within My Computer in Windows, one of the MOS objec-
tives requires that you know how to do it from within Excel. That is explained in a later sec-
tion in this chapter (“Saving and Managing Workbooks”), so if you need to save any files you 
work on in this chapter before you get to that section, simply save them as you always have 
in Windows or take a peek at that section before you proceed.

To get started, let’s take a look at the most fundamental component of Excel’s uniqueness: 
its interface.

 

Understanding Excel’s Interface

 

If you are like me, when you opened Excel for the first time, you were mystified by all the 
boxes, columns, and rows. Excel looks quite different from word processing programs or 
email, so it’s important to understand Excel’s unique file setup and navigation. However, 
before you can see how Excel simplifies these processes for you, it’s important that you under-
stand the names and purposes of everything you see on your screen so you can follow my 
instructions. Let’s get the program up and running and take a look at some of these interface 
features.

Open Excel by selecting Start �

 

 All Programs �

 

 Microsoft Office �

 

 Microsoft Office 
Excel 2003. When Excel opens, you will see a blank worksheet, and the title bar at the top of 
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your screen will say Microsoft Excel – Book1. 

 

Book1

 

 is the name temporarily assigned to a 
new workbook before you save it. Before you learn the names and purposes of all the boxes 
and columns, let’s first look at the different bars at the top of the Excel screen.

 

Investigating the Default Bars at the Top of Your Screen

 

Like virtually all computer programs, all the actions you perform in Excel are executed from 
the commands in the menus or the buttons on the toolbars. To see all of the toolbar buttons 
and menu commands in Excel, click Tools �

 

 Customize. In the Customize dialog box, click 
the Options tab and select the two checkboxes at the top: Show Standard And Formatting 
Toolbars On Two Rows and Always Show Full Menus. Then, click the Close button. By 
default, Microsoft has these set up to show only the most recently used commands, but, for 
clarity purposes, the change you just made lets you see all of them and will make it much easier 
for you to find the commands I refer to throughout this book.

If at any time you don’t see any toolbars I refer to, click View �

 

 Toolbars and check the sub-
menu, which shows most of them. The ones that are present on your screen are checked. 
Simply click the toolbar you want displayed to put a check there. Alternatively, if there’s any 
toolbar you don’t want displayed, simply remove the checkmark by clicking it. If the toolbar 
you are looking for is not in the list, click the Customize command at the bottom of the sub-
menu to see a more complete list of choices. 

 

Toolbar Functions

 

You can choose from a number of toolbars in Excel, and I will cover all of them in the chapters 
of this book. In this chapter, we investigate the bars that are on your screen by default when 
you first open Excel. Check out Figure 1.1, which illustrates a typical view of Excel when you 
open it for the first time. At the top of the screen

 

,

 

 you see the five bars listed here:

 

Title bar

 

The 

 

title bar

 

 tells you the name of the program and the filename.

 

Menu bar

 

The 

 

menu bar

 

 displays menus that list 

 

commands

 

 relative to each menu’s function.

 

Standard toolbar 

 

The 

 

Standard toolbar

 

 includes buttons for the most commonly used file 
management and editing commands.

 

Formatting toolbar

 

You can find the most commonly used formatting commands on the 

 

Formatting toolbar

 

.

 

Formula bar

 

The 

 

Formula bar

 

 shows you which cell is active and the content of that cell.

All of these bars (with the exception of the Formula bar) basically work the same way in 
Excel as they do in Windows or any Windows program.  

Using the buttons on the toolbars saves you time, which is important in the MOS Exam 
because of the exam’s time limit. Instead of having to root through the menus to find a com-
mand, most of the ones you will need during the exam are available on the toolbars. Famil-
iarize yourself with these buttons because you will be using many of them in this chapter, as 
well as throughout this book. 

 

4002book.fm  Page 3  Friday, March 24, 2006  11:36 PM



 

4

 

Chapter 1 �

 

Navigating in Excel and Understanding the Interface

 

F I G U R E 1 . 1

 

The Five Bars at the Top of the Screen

 

The toolbars include 

 

tooltips,

 

 which display when you rest your mouse pointer on any but-
ton. These tips tell you what the button does. 

 

If you don’t see tooltips displayed, choose Tools �

 

 Options. In the Options 
dialog box, select the General tab and click the Function Tooltips option. 
Then, choose Tools�

 

 Customize, and select the Options tab, and click the 

 

checkbox for Show ScreenTips On Toolbars.

 

Before I teach you how to use the toolbars, here are a few tips on managing them.

 

Managing the Toolbars

 

Toolbars can be rearranged, moved to different locations, and detached and left floating on 
the worksheet, depending on your preference. Excel allows you full control of your toolbars. 
Let’s try some moving and resizing to get your feet wet by doing Exercise 1.1.

Title Bar

Standard Toolbar

Menu Bar

Formatting Toolbar Formula Bar
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You can drag toolbars to the sides and bottom of your screen as well. If a tool-
bar is docked on the side of the screen, you will have to move your mouse to 

 

the top of the toolbar instead of the left end to find the four-headed arrow. 

 

Task Pane

 

New to Excel, starting with Office XP, is the task pane. Microsoft added this feature to give 
you a larger, more obvious, area to find some commonly used tasks. Though the task pane in 
some of the other Office programs greatly improves the usability of the program (Power-
Point’s Animation task pane and Word’s Styles task pane, for example), in Excel it doesn’t add 
much new, but it’s worth mentioning. By default, the task pane should appear on the right side 
of your screen when you first open Excel. If it is not there, choose View �

 

 Task Pane.

 

E X E R C I S E  1 . 1

 

Moving and Resizing Toolbars

 

1.

 

From the View menu, choose Toolbars �

 

 Formula Auditing. The Formula Auditing tool-
bar is displayed as a floating toolbar.

 

2.

 

Move your mouse pointer to the top edge of the toolbar, until you see a double-headed 
black arrow. Click and hold this arrow and drag the edge of the toolbar up to make it taller. 
Then drag it down to restore it to its original shape.

 

3.

 

Click your mouse pointer anywhere on the toolbar’s title bar and you will see a four-
headed arrow. Click and hold this arrow to move the toolbar to a different location on 
your screen.

 

4.

 

Drag the toolbar to the top of your screen until it docks itself with your other toolbars.

 

5.

 

Move your mouse pointer to the left end of the docked toolbar until you see your mouse 
pointer turn into the four-headed arrow. Then click and hold to drag the toolbar back to 
a floating position on your worksheet.

 

6.

 

Double-click the toolbar’s title bar. It will redock itself wherever it was last docked.

 

7.

 

Using the four-headed arrow on the left end of the toolbar, drag the Formula Auditing 
toolbar so it is above the Formatting toolbar and below the Standard toolbar.

 

8.

 

Move your mouse pointer to the toolbar’s left end again and, with the four-headed arrow, 
drag it back to the middle of the worksheet.

 

9.

 

Click the X on the right end of the toolbar’s title bar to close it.

 

4002book.fm  Page 5  Friday, March 24, 2006  11:36 PM



 

6

 

Chapter 1 �

 

Navigating in Excel and Understanding the Interface

 

At the top of the task pane is a title bar that shows the name of the task pane you are seeing, 
and it has a black downward-pointing arrow to the right of it. Click that arrow to see the var-
ious choices, such as the New Workbook task pane and the Clip Art task pane.

Table 1.1 briefly explains the purpose of each task pane. You will learn how to use each of 
them in future chapters when they are utilized.

 

T A B L E 1 . 1

 

Elements of the Task Pane 

 

Task Pane Purpose

 

Getting Started/ 
Help/Search Results/
Template Help

These four task panes help you find what you need to know about 
Excel.

Clip Art This pane gives you access to Microsoft’s Clip Art Gallery to search 
for pictures, sounds, and movie files to include in your workbook. 
There’s also a Clip Organizer that lets you include your own files in 
the gallery.

Research Use this task pane to get more information from dictionaries, a the-
saurus, an encyclopedia, and more.

Task Pane Choices
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When you are not using the task pane, you can click the X in the upper-right corner to close 
it and have more room on your screen. If you want it back, just choose View �

 

 Task Pane. 
Also, some commands (like Insert �

 

 Picture �

 

 Clip Art and File �

 

 New) will bring the task 
pane back automatically when you need it. After you’ve explored the various task panes, click 
the X in the task panes upper-right corner to close it.

 

Workbook Components

 

In Excel, you do data entry, formatting, and computing within what is called a 

 

worksheet 

 

(commonly referred to as a

 

 sheet)

 

. One or more worksheets within a single Excel file create a 

 

workbook

 

, which is what an Excel file is called. Think of the workbook as the manila folder 
in your file cabinet and the worksheets as the invoices, inventory lists, customer information 
sheets, and so forth that are included in the manila folder. Look at the bottom of your Excel 
screen; see the tabs that say Sheet1, Sheet2, and Sheet3? By default, Excel includes three sheets 
in a new workbook (see Figure 1.2), but you can create more, as I’ll explain later in the section 
“Organizing Worksheets.”

You can use these sheets to organize data that belongs in one workbook but has differing 
types of information and, therefore, should not be included in one worksheet. An example is 
a workbook you make for one particular company, including individual worksheets for inven-
tory lists, sales records, and customer information. You can also use worksheets to organize 
similar information—creating a separate sheet for each month of the year in a yearly sales 
workbook, for example. 

In Figure 1.2 notice that there are 

 

tab scrolling buttons

 

 to the left of the sheet tabs. You can 
click these buttons to move through the sheets when you have so many tabs that you can’t view 
them all at one time.

 

Clipboard This pane allows you to see up to 24 items stored in your Clipboard 
when you copy or cut data.

New Workbook You use this pane when you create a new blank workbook or want to 
start a new workbook based on a template.

Shared Workspace/ 
Document Updates

Use these panes when you want to create a workspace for multiple 
users.

XML Source This pane is for viewing Extensible Markup Language (XML) maps.

 

T A B L E 1 . 1

 

Elements of the Task Pane

 

(continued)

 

Task Pane Purpose
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F I G U R E 1 . 2

 

Sheet tabs allow you to quickly move from sheet to sheet.

 

When you have a large number of sheets, a quick way to move from one to 
another is to right-click the tab scrolling buttons and pick the sheet you want 

 

from the list that pops up.

 

Workbooks also include both vertical and horizontal scrollbars so you can get to all parts 
of the sheet when it is too large to be displayed completely on your screen.

Worksheet Components

Excel worksheets are organized in columns and rows. The columns are vertical and are labeled 
at the top with letters. The rows run horizontally across the sheet and are labeled on the left 
end with numbers. The individual boxes on the sheet are called cells, and they are named with 
a cell address, according to the column and row intersection where they appear. For example, 
if you move across to column C, then move down to row 6, that cell address would be C6, sim-
ilar to the way towns are listed in the key on a road map. To see the address of any cell, click 
that cell with your mouse pointer, then look at the Name box next to the Formula bar and see 
it displayed there (see Figure 1.3). 

Tab Scrolling Buttons Horizontal Scrollbar Vertical ScrollbarSheet Tabs
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F I G U R E 1 . 3 The Name box displays the cell address of the active cell.

The lines you see defining the cells are called gridlines. They do not print by default, but are 
intended more for clarity when you view the data onscreen.

When you click any cell, you see it is outlined in black, as shown in Figure 1.3. Clicking a 
cell selects it and makes it the active cell, meaning this is the cell that will be affected by what-
ever you type or do.

Now that you’ve read about the basic elements of the Excel interface, it’s time to under-
stand how to navigate around Excel. It’s not as easy as some programs, so it definitely war-
rants a discussion.

Navigating in Excel
Your next goal is to learn how to move around to the various locations in the workbook and 
various places on the worksheets. This section includes exercises that teach you the different 
ways to move around in Excel.

Moving Around in Workbooks

To see all the data in your workbook and edit the data, you must know how to effectively nav-
igate to different worksheets within the workbook. Exercise 1.2 teaches you how to do this.

E X E R C I S E  1 . 2  

Navigating in a Workbook

1. Open Excel and select File � Open.

2. Find the file named Exercise 1-1.xls that you extracted from the zipped file for this chapter.

3. On Sheet1, you can see the January sales for five stores. Click the Sheet2 sheet tab at the 
bottom of the worksheet. This is the March sales sheet.
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Moving Around in Worksheets

 Moving from sheet to sheet is fairly straightforward; however, moving around within a work-
sheet is more complex because sheets can be very large and you can waste a lot of time scroll-
ing to find something. Once you’ve navigated to the sheet you want to work on, you can find 
the particular cell that needs your attention in various ways, as demonstrated in Exercise 1.3.

4. Click Sheet3’s tab to see the February sales sheet.

5. Hold down the Ctrl key on your keyboard and tap the Page Up key. This is the keyboard 
shortcut to move to the previous sheet, so this moves you back to Sheet2.

6. Press Ctrl+Page Down to move back to Sheet3.

7. When you have more sheets than can be displayed at the bottom of the workbook, you 
use the tab scrolling buttons (First, Previous, Next, and Last) shown in Figure 1.2 to dis-
play the unseen sheets. 

8. Leave this workbook open for the next exercise.

E X E R C I S E  1 . 3  

Navigating in a Worksheet

1. Still inside the workbook named Exercise 1-1.xls, click the Sheet1 tab to get back to the 
January sales sheet.

2. Use the vertical scrollbar on the right side of your screen to move the view of the sheet 
up and down.

3. Use the horizontal scrollbar at the bottom of the screen to move the view left and right.

Scrollbars are necessary only when the data on your worksheet will not fit on one screen. 
Since the data in this file does fit on one screen, using the scrollbars has a less obvious 
effect.

4. Press Ctrl+Home to move to cell A1 on this sheet. This is the keyboard shortcut to move 
to the first cell that contains data.

5. Press Ctrl+End to move to cell E8 on this sheet. This is the keyboard shortcut to move to 
the last cell that contains data.

E X E R C I S E  1 . 2 ( c o n t i n u e d )
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It is important to note that if you click into a cell beyond the data area and just put one 
space in that cell, or enter data in that cell and then delete it, Excel will see this as the last 
cell that contains data, so Ctrl+End is not always reliable.

6. Click your mouse pointer in cell A3 to make that the active cell. Press Ctrl+→ to move to 
cell E3, which is the last cell in that row containing data.

7. Click in the Name box at the top of your screen, below your Formatting toolbar. Type a4 in 
this box and press Enter. This capitalizes the A in the Name box and moves you to cell A4.

Note that when you type a cell address in the Name box or in a formula, you don’t have 
to capitalize the column identifier. Excel will recognize it as a cell reference and capitalize 
the letter(s) for you.

8. Press the End key on your keyboard. Look at the Status bar at the bottom of your screen; 
note the word “END” in the lower-right corner. Now press Enter and you will move to the 
last cell on that row that contains data. Press End again to remove the word “END” from 
your Status bar, if it doesn’t automatically disappear.

9. Press the  ↑ , ↓ , ← , and → keys to move from cell to cell.

10. Press the F5 key on your keyboard to bring up the Go To dialog box. Type h77 in the Ref-
erence box and click OK. This takes you to cell H77.

11. Choose Go To from the Edit menu, and it shows you other cells you have recently 
selected. Click one of them and click OK to return to that cell.

12. Press Ctrl+Home to return to cell A1. From the Edit menu, choose Find.

13. In the Find What box, type french, and then click the Find Next button. This takes you to 
cell A6, where the word “French” is located. 

14. Click the Close button to close the Find and Replace dialog box.

15. Press Ctrl+F to open the Find box again. Type 2 in the Find What box. (Note that the word 
french is highlighted in black. Typing 2 will replace what is highlighted.) Click Find Next 
and you will move to cell C7, which is the next cell that contains the number 2.

16. Click the Find All button and the list displayed at the bottom of the Find box shows you 
all the cells on this sheet that contain the number 2. The Value column shows all the val-
ues that include the number 2. Click the one that shows Week 2 and you move to cell C3. 
To find all occurrences in the workbook, click the other sheet tabs and click Find All again.

17. Close the Find and Replace dialog box and close the file. Do not save any changes. 

E X E R C I S E  1 . 3 ( c o n t i n u e d )
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Excel has many keyboard shortcuts, and it is not possible to show you all of 
them.  However, they are all included in Excel’s Help files. From the Help menu, 
choose Microsoft Excel Help and the Excel Help task pane will appear. In the 
Search For box, type keyboard shortcuts and click the green arrow button. Then 
click the Keyboard Shortcuts links. Also note that when you choose commands 
from the menus, many of the commands show keyboard shortcuts beside them.

Now that you know the fundamentals of how to move around your worksheets and work-
book, let’s look at managing your data and cells.

By default, when moving from cell to cell, pressing Enter moves you to the 
cell below the one you are currently in, and pressing Tab moves you to the cell 
to the right. Pressing these keys is usually the quickest way to move from 
cell to cell when you’re entering data.

Adding and Editing Data in a Workbook
Adding to or editing information in an Excel workbook is referred to as data management. 
Data is the term used to refer to what’s inside the cells. You can also manage the actual cells, 
rows, and columns without actually changing the data within them. This section shows you 
the difference between data management, cell management, and row and column manage-
ment, and the basics of doing each.

Managing Data in Cells

There are basically two types of data in Excel: labels and values.

Label Refers to text typed at the top of a column or to the left of a row to identify the infor-
mation contained in the column or row.

Value Is the actual information listed in the rows and columns, below, or to the right of the 
labels. 

Figure 1.4 shows you a typical worksheet layout, using labels and values. The title at the 
top, the store names, and the numbered weeks are examples of labels. The values in dollars 
and the word closed are examples of values. Notice that labels and values can consist of text 
and/or numbers.

Between cell formatting and manual editing of cell contents, you can make Excel display 
your data in many different ways. Most of the cell formatting options will be discussed in 
Chapter 2, “Formats, Graphics, and Excel’s Templates,” but the following exercises will show 
you how to add new data to and edit existing data in a worksheet. Exercise 1.4 teaches you 
how to add new data to an existing worksheet.
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F I G U R E 1 . 4 Cells can contain labels or values.

E X E R C I S E  1 . 4  

Adding Data to a Worksheet

1. Open the file Exercise 1-1.xls.

2. Move to Sheet2 and click cell A9. On the Status bar at the bottom of your screen, on the 
left end you see the word Ready. This means the cell is now the active cell and ready for 
your input.

3. Type the word Florence. As soon as you start typing, the word on the Status bar changes 
to Enter. This means you are now entering data in this cell. (Also notice that what you 
type in the cell appears in the Formula bar above.)

4. Press Enter and you move to the cell immediately below this. Your Status bar shows 
“Ready” again.

5. Press ↑ to return to cell A9. Press either → or Tab to move to cell B9.

ValuesLabels Label Labels
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Once data is in a worksheet, there are various ways to modify that data at a later time, if 
you need to update it. 

An important thing to note is that anything typed within a cell is not committed until you 
press the Enter key. When in Edit or Enter mode, if you start to change or replace the content 
of any cell but change your mind, pressing the Esc key on your keyboard will revert the con-
tent to what it was originally, as long as you have not yet pressed Enter and left the cell. If 
you have already left the cell, use the Undo button on your Standard toolbar to undo the last 
action. 

6. In cells B9 through E9 enter the numbers shown here, pressing your Tab key after you 
type each one:

In B9, type 450, and then press Tab to move to C9.

Type 550.5, and then press Tab to move to D9.

Type 675.95, and then press Tab to move to E9.

Type 1000. 

7. After you type 1000 in E9, press Enter to move down to E10, then press Home to move 
to the beginning of row 10.

8. In rows 10 and 11, add the data shown here, using the method described earlier:

In A10, Flora; in B10, 300; in C10, 899.5; in D10, 1600; in E10, 1297

In A11, Fauna; in B11, 1499; in C11, 1076; in D11, 1187.99; in E11, closed

9. You have now added three new stores to your worksheet, and it should look like the 
worksheet shown here: 

10. Leave this workbook open for the next exercise.

E X E R C I S E  1 . 4 ( c o n t i n u e d )
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To the right of the Undo button is a small downward-pointing dropdown 
arrow. Click this arrow to open a list of all you’ve done recently, so you can 
undo more than one action if necessary.

Exercise 1.5 illustrates ways to edit all or part of the content of a cell.

E X E R C I S E  1 . 5

Editing Data in a Worksheet

1. Still inside Exercise 1-1.xls, select cell A9 by clicking it one time. Notice your Status bar 
shows “Ready.” When you want to totally change the content of a cell, you do not need 
to delete what is in the cell first. Simply type what you want and press Enter, and the con-
tent will be replaced. Type Rosewood and press Enter. Notice that the content has been 
changed.

2. Select cell D4. In this case, we don’t want to change the entire contents. Instead, we only 
want to change one digit in this number. We want to change 10000.5 to 11000.5. To do this, 
we need to move from Ready mode to Edit mode; this can be done in one of three ways:

� Double-click any cell and your Status bar shows “Edit.”

� Click any cell, then press F2 and your Status bar shows “Edit.”

� Click any cell; then click in the Formula bar where you see the cell content below the 
Formatting toolbar. Your Status bar shows “Edit.”

3. Once you use one of these three methods to get into Edit mode, in cell D4 you will see an 
I beam. This I beam designates the insertion point, which shows where your typing will 
be entered within the cell. Use your ← and → keys to move to the right of the number 1, 
press the Delete key on your keyboard one time to remove one of the zeroes, and then 
type 1. 

4. Press Enter and the content of the cell now shows 11000.5.

5. Using the methods described earlier, change the contents of the following cells to these 
new values:

� Change B6 to 1275.75.

� Change A4 to Burberry.

� Add 50 to cell D8.

6. Leave this workbook open for the next exercise.
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Managing Cells

Because all cells in a column must be the same width and all cells in a row must be the same 
height, cell size management doesn’t include too many options. Most cell size management is 
governed by the specifications set on the row or column that contains the cell. You can work 
around some of this by merging cells, a process that is covered in Chapter 2.

Cells can be deleted and cleared individually, but deleting a cell is different from clearing 
or deleting the content of a cell. Clearing a cell just removes the content, whereas deleting a 
cell removes the entire cell and shifts the cells around it to fill the area where that cell was orig-
inally. As Figure 1.5 shows, you can shift the cells up or to the left when deleting a cell. 

F I G U R E 1 . 5 When you delete a cell, you have choices for how you want the space filled.

Exercise 1.6 walks you through deleting content and deleting whole cells.

E X E R C I S E  1 . 6  

Deleting Cells and Clearing Cell Components

1. Still inside Exercise 1-1, move to Sheet1 and select cell D6.

2. Press Delete and then press Enter. Notice that the content in cell D6 has been removed. 

3. Click the Undo button to restore the value of 500 into cell D6.

With cell D6 still selected, go to the Edit menu and rest your mouse pointer on the Clear 
command. As you can see, you have four choices: All, Formats, Contents (Del), and 
Comments. Pressing the Delete key removes the contents of the cell but leaves any for-
matting that has been applied to the cell. To remove all of this, use the Edit� Clear � 
All command.

4. Select cell C6.

5. Go to the Edit menu and choose Delete.

6. Verify that Shift Cells Up is selected and click OK. 
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Managing Rows and Columns

Managing rows and columns involves everything from changing their size to accommodate 
the data you want to display to adding and deleting rows and columns. We’ll discuss these 
issues in further detail and, of course, practice these maneuvers as well.

Changing the Size of Rows and Columns

Rows and columns that are not large enough can cause data to be displayed and printed incor-
rectly. And, based on certain variables, Excel will treat data that is too wide for a column dif-
ferently. Look at Sheet1 in the file Exercise 1-1.xls and you’ll notice that the text in cell D7 is 
cut off because it is wider than what the column allows. However, notice that the text in E7 
is not cut off but instead spills out of the column and appears to continue into column F. Look 
at Sheet2 and click cell C5 (the cell that is displaying multiple # signs). Observe in the Formula 
bar that this cell actually has a number in it, but because the number is too wide for the col-
umn, Excel replaces that number with the # signs. These dissimilarities are the result of the way 
Excel adapts to data that is too wide for a column, based on two criteria:
� Is there anything in the cell immediately to the right of the data?
� Does the cell contain text or numbers?

If text is too wide for a column, Excel will allow the text to spill out over the next column 
if the cell to the right is empty. However, if there is something in that cell to the right, the data 
that is too wide for the column will be cut off.

The illustration here shows that the value 21000 that was in C7 has now moved up into 
C6, and that 12000.75 has moved up into C7. When you delete a cell, the gap must be 
filled. When you simply clear the contents of a cell, the cell still remains but is empty.

7. Click the Undo button so that 21000 is back in cell C7, as shown in the “Before” part in 
the illustration.

8. Leave this file open for the next discussion and exercise.

E X E R C I S E  1 . 6 ( c o n t i n u e d )
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18 Chapter 1 � Navigating in Excel and Understanding the Interface

If numbers are too wide for a column, Excel will replace the digits with # signs if the cell 
to the right of it has something in it. However, if the cell to the right is empty, Excel will cut 
off the digits that exceed the width of the column, rounding the number off if necessary.

It is important for you to know that what you see in a cell is not always what Excel sees in 
that cell. For example, when Excel rounds off a number to fit it in a column, Excel still sees 
the full number. To always know exactly what Excel is seeing in a cell, look at what is in the 
Formula bar at the top of the screen. That is the only place you will always see exactly what 
Excel sees. For example, 1.5 rounded off to fit in a narrow column will show as 2 in the cell, 
but Excel will still show it as 1.5 in the Formula bar; therefore, when you use a formula to add 
two cells together that seem to have 2 in them, you will get a result of 3, because Excel is actu-
ally adding 1.5 and 1.5. (I’ll cover more on using formulas in Chapter 5, “Formulas and Func-
tions in Excel.”) 

The following exercises will teach you how to adjust column widths, as well as row heights, 
using the mouse or the menu commands. First, in Exercise 1.7, let’s try it with the mouse.

E X E R C I S E  1 . 7  

Resizing Rows and Columns Using the Mouse

1. Go to Sheet1 in Exercise 1-1.xls.

2. Move your mouse pointer up to the column headers section—the gray area at the top of 
the worksheet that displays the column letters A, B, C, etc.

3. Move your mouse pointer over the gridline between the letters D and E until you see the 
resizing pointer, as shown here:

4. With this pointer you can:

� Hold down the left mouse button and drag the right edge of the column until the col-
umn is wide enough.

� Double-click to automatically fit the column to the widest entry in it.
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In Exercise 1.8, we’ll explore an alternative method for resizing the columns and rows pre-
cisely, using the menus.

5. Drag the right edge of the column until all of the text in cell D7 is visible. Then drag the 
edge back to the left until the # signs reappear. 

When you drag the column headers with the resizing pointer, you see a tooltip that tells 
you the exact column width. The first number you see is the size in characters; the second 
number, in parentheses, is the size in pixels. 

6. Now, try double-clicking to let Excel automatically adjust it to the length of the value in D7.

7. Move to Sheet2 and double-click between the column headers for C and D to display the 
full number in C5.

8. Change the number in cell E5 to 9501.977 and press Enter. Notice that the full number is 
still displayed because it fits within the column.

9. Edit the number in E5 by adding a 9 at the end so that it now shows 9501.9779, and press 
Enter. See that the number is shortened by one digit so that it fits within the column, and 
is rounded to 9501.978.

10. Double-click between column headers E and F to adjust the column so the full number in 
E5 is displayed.

11. Adjusting row height is similar to adjusting column width. Move your mouse pointer 
over the gridline between the row headers on the left of your screen that say 3 and 4 until 
you see the resizing pointer; then drag down to increase the height of row 3. The tooltip 
that appears when you drag to adjust row heights shows the size in points first (1 point 
equals 1/72 of an inch), followed by the size in pixels, in parentheses.

12. Double-click with the resizing pointer to make row 3 automatically adjust to the height of 
the text in that row. 

13. Leave the file open for the next exercise.

E X E R C I S E  1 . 8  

Resizing Rows and Columns Using the Menus

1. Move to Sheet2 in Exercise 1-1.xls.

2. Change the column heading labels in cells B3 through E3 so the week numbers are 
spelled out, making them Week One, Week Two, Week Three, and Week Four.

E X E R C I S E  1 . 7 ( c o n t i n u e d )
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Adding and Deleting Rows and Columns

Sometimes you just need a little more information: another row or column to finish off your 
report, or wrap up that expense worksheet. When this is the case, you can add new rows or 
columns within your data area. When you insert a column or row, by default it takes on the 
formatting from the column to the left or the row above, if the cell to the left or the cell above 
has data in it. You can click the option button that appears on the lower-right corner of the 
active cell to change the formatting to match the column to the right or the row below, or 
choose to have no formatting attached to the new column or row (see Figure 1.6).

F I G U R E 1 . 6 Option buttons give you easy choices to change default formatting.

3. Notice that Week Three is now cut off. Click any cell in column D.

4. From the Format menu, move down to Column and choose Autofit Selection. The col-
umn width adjusts to fit the widest item in that column. This is the same as double-click-
ing the gridline to the right of any column header, as we did in Exercise 1.7.

5. Click any cell in column A and select Format � Column � Width. Type 10 in the Column 
Width box and click OK. Notice the column widens to 10 characters.

6. Click in any cell in the worksheet and select Format � Column � Standard Width. Type 12.5 
in the Standard column width box and click OK. Notice that any column in the worksheet 
that was set at Excel’s default width of 8.43 is now 12.5 characters wide, whereas columns 
that had been changed from the standard width are not altered. Obviously, all empty col-
umns have been adjusted to 12.5 because they are still set to standard width.

7. Row heights have the same adjustment options, except you cannot change the standard 
height setting. Select Format � Row and you’ll see options for Height and Autofit. Click 
anywhere in row 3, and select Format � Row � Height. Change the height to 3 points, and 
then click OK. Notice that the row height is too small and the data is cut off.

8. Still in row 3, go back to Format � Row and choose Autofit, and the row adjusts to fit the 
height of the text in that row, which is the same as double-clicking the gridline below the 
row header, explained in Exercise 1.7. 

9. Leave the file open for the next exercise.

E X E R C I S E  1 . 8 ( c o n t i n u e d )
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As I’m sure you’re aware, if you want to delete all the data in a column or row but leave 
the empty column or row in the worksheet, you just select the cells that have the data in them 
and press the Delete key, or use the Edit � Clear command, or use the right-click shortcut 
menu. But if you want to remove unnecessary rows and columns completely and, in the pro-
cess, automatically adjust the column and row headers, you have a little more of a process to 
follow, which I will address in Exercise 1.9. 

Hiding Rows and Columns

Assume you have a large worksheet and want to edit data in only a few columns or rows, or 
you want to print a special printout that shows only specific columns or rows. In this case, you 
wouldn’t want to permanently delete the unneeded rows or columns, but instead just hide 
them temporarily. Exercise 1.10 shows you how to do this.

E X E R C I S E  1 . 9

Adding and Removing Rows and Columns

1. Still inside Exercise 1-1.xls, move to Sheet3. Click anywhere in column C.

2. Go to the Insert menu and choose Columns, and a new empty column is added to the left 
of column C. The new column is now column C and the original column C data is moved 
to column D.

3. Right-click in the newly created column C and choose Insert from the shortcut menu. 
When the Insert box comes up, choose Entire Column and click OK. This adds a new col-
umn to the left, and again, the column headers are adjusted. (Notice that right-clicking a 
cell also allows you to choose Shift Cells Right or Shift Cells Down if you only want to 
insert a single cell instead of an entire column or row.) 

4. Right-click again and choose Insert � Entire Row and click OK. This adds a new empty 
row above the row you are in. This option is also available when you choose Insert � Rows.

5. Click any cell in one of your new empty columns and choose Delete from the Edit menu, 
then choose Entire Column and click OK.

6. Right-click the other empty column you inserted and choose Delete � Entire Column, 
then click OK. Be sure to delete all of the empty columns you inserted.

7. Using either the Edit or right-click menu, delete the empty row(s) you have inserted by 
choosing Delete � Entire Row and clicking OK.

8. Leave the file open for the next exercise.
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If you accidentally drag to select multiple cells using the wrong mouse 
pointer, cells may move or copy themselves. This is not what you want 
to do, so use your Undo button if the incorrect action occurs.

Organizing Worksheets

You may have noticed that the worksheets in Exercise 1-1.xls are not in the correct order and 
that the sheet tab names are not relevant to the data included in the sheets. The first sheet 
shows sales for January, the second sheet shows the March data, and the third shows Febru-
ary’s information. The exercises in this section will show you how to perform all sorts of 
worksheet tasks. You’ll learn to rename the sheets with names that reveal what is on the sheet. 
You’ll also learn how to color-code sheet tabs, as well as how to move, copy, delete, insert, and 
hide/unhide sheets.

E X E R C I S E  1 . 1 0

Hiding and Unhiding Rows and Columns

1. Move to Sheet1 in Exercise 1-1.xls and click any cell in column D.

2. From the Format menu, choose Column � Hide. Notice column D is now hidden and the 
column headers show A, B, C, E.

3. If you immediately go back to the Format menu and choose Column � Unhide, the column 
you just hid would return to view. But, instead of doing that, click any cell in column F and 
choose Format � Column � Unhide. As you’ll see, nothing happens.

4. Click any cell in column C and, holding your mouse button down, drag to select the cell 
to the right of it in column D so that both cells are selected. Be sure your mouse pointer 
is a white plus sign while dragging, and not a black four-headed arrow or black plus sign 
(these other pointers will be explained later).

5. With the two cells selected, choose Format � Column � Unhide, and column D will return 
to view. To unhide a column, you must select cells on both sides of the hidden column 
beforehand.

6. Once you have unhidden column D, click in any cell and hide that row by choosing For-
mat � Row � Hide. Notice the row is removed from view and the row header numbers 
omit that number.

7. Select a cell in the row above the hidden row, and drag with the white plus sign to select 
a cell in the row below the hidden row. Choose Format � Row � Unhide to bring the row 
back into view.

8. Leave the file open for the next exercise.
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Be aware that many of the actions performed in the exercises in this section 
cannot be undone by simply clicking the Undo button. If you move a sheet to 
the wrong location, delete the wrong sheet, rename a sheet incorrectly, and 
similar mistakes, and then try to backtrack using the Undo button, you will 
notice that it does nothing. In these cases, you will have to manually correct 
the action.

Making Sheet Tabs Make Sense

In order for your sheets to make sense and be well organized, you can name them and color-
code them for clarity. It’s much easier to find something in a workbook if the sheet tabs are 
obvious. Exercise 1.11 explains how to accomplish this.

E X E R C I S E  1 . 1 1

Renaming and Color-Coding Worksheets

1. Move to Sheet1 in Exercise 1-1.xls. Double-click the Sheet1 sheet tab; the name is high-
lighted in black.

2. Type January Sales and press Enter.

3. Right-click the Sheet2 tab and choose Rename. Type March Sales and press Enter.

4. Choose the method you prefer and either double-click Sheet3’s tab or right-click Sheet3’s 
tab and choose Rename. Type February Sales and press Enter.

5. Right-click the sheet tab that now reads January Sales and choose Tab Color. When the 
Format Tab Color box comes up, click any color you like, then click OK. Notice January 
Sales is now underlined in that color.

6. Click the March Sales tab to select that sheet. The January Sales tab is now fully colored 
in the tab color you chose for it.

7. With the March Sales sheet displayed, go to the Format menu and choose Sheet � Tab 
Color. Again, choose a color and click OK. Now the March Sales sheet tab is underlined 
in that color.

8. Move to the February Sales sheet and either right-click it or use the Format menu to 
change the color of that tab.

9. Notice that the active sheet shows a white tab with its name underlined in the chosen 
color, whereas the inactive sheets show the tabs in their full colors. Also, you can see that 
the active sheet tab has bold text.

10. Leave the file open for the next exercise.
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Once the worksheets have self-explanatory names and are categorized by color, the next 
important step is to put them in some logical order. For example, sheets that include data from 
different time periods should be in chronological order, or sheets that have no real logical 
order based on their contents should be in alphabetical order. The important thing is that the 
order makes sense to you and any others using this workbook, similar to the way a filing sys-
tem should be intuitive to the people using it.

Arranging Worksheets in a Logical Order

Don’t forget that workbooks can become quite large and the number of worksheets increases 
as you add new data. Think of the sheets as chapter names in a book and how important it is 
to have those chapters in a sequence that makes sense. Use the instructions in Exercise 1.12 to 
put the sheets in the correct order and add new sheets.

Using Tab Colors

Applying different tab colors not only makes it easier to see which sheet is active, but color 
coding also works well for categorizing the worksheets. I once helped a company that used a 
workbook to keep records of sales for different stores in a chain. There were 20 stores and 
each store was part of either the Eastern region or the Western region categories. A separate 
worksheet was made for each store, with the tab showing the name of that store, and that 
worked well for them. However, they wanted a quick way to identify which store was in which 
region. So, we color-coded the sheet tabs so that all stores in the Eastern region had red tabs, 
while all stores in the Western region had blue tabs. This was very helpful to the company.

E X E R C I S E  1 . 1 2  

Inserting, Moving, and Copying Worksheets

If you want to move a worksheet to a different location, you can simply drag it with your 
mouse and drop it where you want it. 

1. Click the March Sales sheet tab in Exercise 1-1.xls.

2. Holding your mouse button down on the tab shows a white sheet of paper attached to the 
mouse pointer. Continue to hold the mouse button down and move the pointer until it is 
positioned to the right of the February Sales tab. The small black arrow pointing down-
ward indicates where the sheet will be placed when you release the mouse button. When 
you see the black arrow to the right of the February Sales tab, release the mouse button.
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3. Your sheets should now be in order, beginning with January and ending with March.

4. Click the February Sales tab to make that sheet active. Right-click the tab and choose 
Insert.

5. When the Insert dialog box comes up, make sure Worksheet is selected and click OK.

6. You now have a new blank worksheet named Sheet1 inserted to the left of the February 
Sales sheet. New worksheets are always added to the left (before) the active sheet.

7. Rename Sheet1 to Yearly Totals and color the tab any color you choose.

8. Right-click the Yearly Totals tab and choose Move Or Copy. When the Move Or Copy dia-
log box appears, click the text that reads “(move to end)” in the list of choices under 
Before Sheet. Click OK. Now the Yearly Totals sheet is the last one.

9. With the Yearly Totals sheet active, select Insert � Worksheet. A new Sheet2 is now 
added to the left of the Yearly Totals sheet.

10. Rename the new sheet 1st Qtr Sales.

11. Inside the 1st Qtr Sales sheet, select Edit � Move Or Copy Sheet. 

12. From the Before Sheet list, choose Yearly Totals and select the Create A Copy option. 
Click OK. This places a sheet named “1st Qtr Sales (2)” between the 1st Qtr Sales and 
Yearly Sales sheets.

13. Use the methods from steps 8, 11, and 12 to make two more copies of the 1st Qtr Sales 
sheet, so you have 1st Qtr Sales (3) and 1st Qtr Sales (4) also inserted before Yearly Sales.

14. Rename the new sheets 2nd Qtr Sales, 3rd Qtr Sales, and 4th Qtr Sales.

15. Using the previous techniques, either create nine new blank sheets or copy any of the 
empty quarterly sheets until you have sheets for each month. Then rename the sheets to 
reflect the month for which they are intended.

16. Either by dragging or right-clicking and moving, rearrange all your sheets until they are 
in this order: 

January Sales

February Sales

March Sales

1st Qtr Sales

April Sales

May Sales

E X E R C I S E  1 . 1 2 ( c o n t i n u e d )
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Deleting and Hiding Worksheets

As with rows and columns, sometimes you want to remove sheets, either permanently or tem-
porarily. Deleting an entire worksheet is an action that cannot be undone by using the Undo 
button, so instead of having you actually delete sheets, I will simply tell you how to do this. 
If you choose to do it, you will have to re-create the sheets manually so you have all of them 
for future exercises.

To delete a worksheet, you can do one of the following:
� Right-click a sheet tab and choose Delete.
� Select Edit � Delete Sheet.

June Sales

2nd Qtr Sales

July Sales

August Sales

September Sales

3rd Qtr Sales

October Sales

November Sales

December Sales

4th Qtr Sales

Yearly Totals

You may need to use the tab scrolling buttons to the left of your sheet tabs to see all of 
your tabs (see Figure 1.2).

17. Once your sheets are renamed and in the correct order, recolor the tabs so the first month 
of every quarter is the same color, the second month of every quarter is the same color, the 
third month of every quarter is the same color, the quarterly tabs are the same color, and 
the Totals sheet tab is a unique color.

18. Leave the file open for the next exercise.

E X E R C I S E  1 . 1 2 ( c o n t i n u e d )
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Alternatively, sometimes you don’t want to permanently delete the sheet but instead just 
want it out of view temporarily. Exercise 1.13 shows you how to hide worksheets and then 
how to unhide them again.

Saving and Managing Workbooks

When you create a new workbook from scratch, you see in the title bar that Excel temporarily 
names it Book1, Book2, and so forth. When you save this new workbook for the first time, 
either by clicking the Save button on the Standard toolbar or by choosing Save from the File 
menu, the dialog box that appears is named Save As. You can use this box to do three things:

1. Name the file.

2. Choose the location where you want to save it.

3. Choose the file type you want for this file.

However, in that same workbook, if you make more changes and then click the Save but-
ton, or choose File � Save, you will not see the Save As dialog box again. Instead, the file will 
just be saved with the same name you first chose, in the same location and with the same file 
type. The original file will be completely overwritten by the one you save the second time. The 
original file will no longer be available; only the newer version with the changes will exist.

If instead you want to save the new version with a different name, or in a different location, 
or as a different type, you must use File � Save As.

Though you can create folders in the Windows Explorer or My Computer windows, Exer-
cise 1.14 will show you how to use Excel to manage your files and folders in an orderly fash-
ion, which is one of the MOS objectives you could be tested on. The exercise also introduces 

E X E R C I S E  1 . 1 3

Hiding and Unhiding Sheets

1. Click the 1st Qtr Sales sheet tab in Exercise 1-1.xls.

2. From the Format menu choose Sheet � Hide. The sheet tab no longer appears.

3. Repeat step 2 to hide the 2nd Qtr Sales, 3rd Qtr Sales, and 4th Qtr Sales sheets.

4. To unhide sheets, select Format � Sheet � Unhide.

5. A list appears that shows all your hidden sheets. Choose one and click OK to bring that 
sheet back into view.

6. Repeat steps 4 and 5 until all sheets are unhidden.

7. Leave the workbook open for the next exercise.
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you to the dropdown box where you can choose different file format types when saving. Be 
sure to look through the type choices and understand them.

E X E R C I S E  1 . 1 4  

Using Save and Save As 

1. Inside the current workbook that you have been editing, select File � Save As.

2. You will see this dialog box:

3. The file location shown will most likely be the place where the original file was located. 
Click the icon on the left that reads “My Documents.” At the top, in the Save In box you 
now see My Documents.

4. Click the yellow starred folder icon to the right of the Save In box to create a new folder 
inside your My Documents folder.

5. When the New Folder box appears, type Excel 2003 MOS Projects as the name of your 
new folder and click OK.

6. You are now inside your new folder. Click the New Folder icon again.

7. This time, type Chapter One and click OK.

Change the File Type

Choose a Location

Name the File

Create a New Folder
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An even quicker way to close your file and close Excel is to click the X on the 
far-right end of your menu bar to close the file; then click the X above that on 
your title bar to close Excel. 

Moving and Copying Data
Often you have repetitive data that you want placed in more than one location in your work-
book, or you simply want to move your data from one place to another. Excel offers various 
ways to do this. First, let’s look at simple copying and pasting.

Copy and Paste

There are various methods of copying and pasting that are specific to Excel. Something you 
will notice when you copy data in Excel is a moving marquee around the copied data. This is 
the way Excel shows you that something is on your Clipboard. To clear the data from the Clip-
board, you simply press the Esc key on your keyboard and the marquee disappears. 

Exercise 1.15 explores the different ways to copy and paste in Excel.

8. You are now inside the Chapter One folder, which is inside the Excel 2003 MOS Projects 
folder.

9. Now, it is time to name the file. In the File Name box near the bottom of the Save As box, 
type Exercise 1-14 to replace what is already there.

10. As you can see, the Save As Type box contains Microsoft Office Excel Workbook (*.xls). 
Click the dropdown arrow at the right end of that box. This is where you can choose a dif-
ferent format if you will be sharing this file with someone who does not have Excel 2003. 
However, for this exercise you will be choosing the default, so scroll to the top of the 
choices and click Microsoft Office Excel Workbook (*.xls) again.

11. Confirm that you are saving the file inside your Chapter One folder, that you have named 
the file correctly, and that you have the default file type selected; then click Save.

12. Close the file by choosing File � Close; then exit Excel by selecting File � Exit.

E X E R C I S E  1 . 1 4 ( c o n t i n u e d )
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E X E R C I S E  1 . 1 5  

Methods of Copying and Pasting

1. Open Excel and select File � Open. Browse to find the file you saved at the end of the last 
exercise, named Exercise 1-14.xls, and open it. (If you did not do the last exercise or think 
you may have omitted some steps up to this point, extract Exercise 1-14.xls from the 
zipped file for this chapter.)

2. Go to the January Sales sheet.

3. Select cell A7, which contains the store name Riley, and copy it, using one of these methods:

� Click the Copy button on the Standard toolbar.

� Choose Copy from the Edit menu.

� Use the keyboard shortcut Ctrl+C to copy it.

� Right-click the cell and choose Copy.

4. Notice the moving marquee once you have copied the cell.

5. Now move to the February Sales sheet. Click cell A8 and paste, using one of these methods:

Click the Paste button on the Standard toolbar.

Choose Paste from the Edit menu.

Use the keyboard shortcut Ctrl+V.

Right-click the cell and choose Paste.

6. Move to the March Sales sheet and use one of the Paste methods to paste it again, this 
time into cell A12. Whatever is copied remains on the Clipboard for you to paste over and 
over, until you copy or cut something else to overwrite it or you remove it from the Clipboard.

7. Go back to the January Sales sheet and you’ll notice that the moving marquee is still 
present on cell A7. Press the Esc key on your keyboard and the marquee disappears. 
Notice that the Paste button on the Standard toolbar is now grayed out. If you right-click, 
you will see Paste is also grayed out, and if you go to the Edit menu, Paste is grayed out 
there as well. Removing the marquee from the cell removes the data from the Clipboard.

8. Using the copy and paste techniques above, copy cell D7 on the January Sales sheet and 
paste it into cells B8, C8, D8, and E8 in the February Sales sheet. Remember to widen your 
columns if the text is cut off.

9. Go to the March Sales sheet and continue to paste into cells B12, C12, D12, and E12, and 
again, widen your columns if necessary.

10. Return to the January Sales sheet and copy cell A4. (If you are simply going to select a 
new cell to copy, you don’t need to remove the marquee from the original selection; 
Excel will do that automatically.)
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Cut and Paste

Excel also offers different ways to cut and paste both single cells and ranges of cells. When you 
select multiple cells, the first cell in the selection does not appear to be highlighted. However, 
if you look at the Name box to the left of the Formula bar, you will see the name of that cell 
in that box. This assures you that that cell is indeed included in the selection.

It is important to note that if you use the right-click method to copy or cut cells and you 
right-click outside the cell or cells you want to copy or cut, you will copy or cut the wrong 
data, or no data at all. Be sure you right-click in the correct place.

Exercise 1.16 teaches you how to cut and paste, and also shows you how to apply the com-
mands to a range of cells instead of just a single cell.

11. Move to the March Sales sheet and select cell A4 and paste. Note when you paste data 
into a cell that already contains data, the new data overwrites the old.

12. Follow the instructions in Exercise 1.14 to save the file (using the Save As command) into 
your Chapter One folder, but this time, name the file Exercise 1-16.xls. Leave the file open 
for the next exercise.

E X E R C I S E  1 . 1 6  

Methods of Cutting and Pasting

1. Still inside the file you worked on in Exercise 1.15, go to the February Sales sheet.

2. Click cell A8, and holding your mouse button down, drag to select cells A8, B8, C8, D8, 
and E8. Be sure you are using the white plus sign. You will know you did it correctly if all 
five cells are highlighted.

3. With all five cells selected, cut the cells using one of these methods:

� Click the Cut button on the Standard toolbar.

� Choose Cut from the Edit menu.

� Use the keyboard shortcut Ctrl+X to cut it.

� Right-click within the selected cell’s area and choose Cut.

4. Right-click cell A7 and choose Paste. The pasted information overwrites what was origi-
nally in row 7. In this case, that is not what we want, so click the Undo button.

5. Click any cell in row 7 and select Insert � Row. This adds a blank row above the Madison 
information.

6. Now highlight all the data again (note that it is now in row 9 because you inserted a 
new row). 

E X E R C I S E  1 . 1 5 ( c o n t i n u e d )
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Selecting Contiguous and Noncontiguous Ranges

Now that you know how to cut, copy, and paste data, as well as how to delete data, cells, and 
whole rows and columns, it is time to learn how to select multiple cells at one time so you can 
perform these actions on contiguous or noncontiguous blocks of cells, rows, or columns. 
Again, before you begin, you must understand what certain terms mean:

Range The term applied to any block of cells. In Excel, a range is designated or named by 
showing the first cell in the range, then a colon (:), then the last cell in the range. For example, 
the range of cells that starts at cell A1 and continues down and to the right to cell E5 would 
be called A1:E5 (see Figure 1.7).

F I G U R E 1 . 7 The selected range, A1:E5, includes contiguous cells.

Contiguous Refers to cells that are adjacent to each other. The range in Figure 1.7 is a range 
of contiguous cells.

Noncontiguous Refers to cells or ranges that are not adjacent to one another. If I selected 
cells A3, B5, and the range C6:E8, I would be making a noncontiguous selection (see 
Figure 1.8).

When you paste a range, you do not need to select the range where it will be pasted. Simply 
click the first cell of the targeted range area, and paste there. Excel will determine how many 
cells are needed and fill the cells appropriately. Another quirk about pasting in Excel is when 
you paste cells, the column width settings are not automatically pasted along with the data and 

7. Cut the data, and then click cell A7 and paste.

8. Move to the March Sales sheet, and then highlight the data in cells A12 through E12 and cut it.

9. Right-click cell A7 and choose Insert Cut Cells. This pastes the cells in a new row above 
the cell you were in when you chose the Insert command. (If you would prefer to use the 
menu instead of right-clicking, click cell A7 and choose Insert � Cut Cells.)

10. Save the file by clicking the Save button on the Standard toolbar or by choosing File �  
Save. This will overwrite the file with the newer version. Close the file. 

E X E R C I S E  1 . 1 6 ( c o n t i n u e d )
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other formatting attached to the cells. Column widths must be pasted separately. After you 
have pasted the data, you will have to leave the range selected and choose Edit � Paste Special, 
then select Column Widths in the Paste Special dialog box that opens.

F I G U R E 1 . 8 This is an example of a noncontiguous selection of cells and ranges.

Exercise 1.17 will show you how to select contiguous ranges and move, copy, paste, and 
delete them.

E X E R C I S E  1 . 1 7  

Selecting Contiguous Ranges

1. Open the file Exercise 1-16.xls that you saved at the end of the last exercise. (If you did 
not save this file, extract it from the zipped file for this chapter.)

2. Move to the March Sales sheet.

3. Click cell A3. Be sure your mouse pointer is the white cross, and hold your mouse button 
down and drag to select the range A3:A12.

4. Using one of the copy methods described in Exercise 1.15, copy the range.

5. Move to the 1st Qtr Sales sheet. Click cell A3 and use one of the paste methods described 
in Exercise 1.15 to paste the data.

6. Move back to the March Sales sheet. You’ll notice the marquee moving around the range 
you copied. Do not bother to press Esc to remove the marquee. Simply highlight the 
range B3:E3 and copy that.

7. Move to the 1st Qtr Sales sheet; click cell B3 and paste.

8. With the pasted range still selected, choose Edit � Paste Special and select Column 
Widths. Then click OK. Now your columns adjust to the same widths as the columns that 
held the data you copied.

9. Move back to the March Sales sheet, highlight the range A12:E12, and cut it.

10. Move to the April Sales sheet, click cell A12, and paste.
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Selecting contiguous ranges is fairly straightforward. However, to select noncontiguous 
ranges, you must use some keyboard combinations. Excel will not let you cut or copy non-
contiguous cells; however, you can delete them or format them all at one time, so there are still 
many uses for noncontiguous selections. Exercise 1.18 shows you what happens when you try 
to cut or copy noncontiguous selections.

11. Move back to the March Sales sheet and you’ll see that the data you cut is gone.

12. Go to the 1st Qtr Sales sheet and select (highlight) the range B3:E3 (which may already 
be selected because pasting it there was the last action you did on that sheet). With that 
range selected, press the Delete key on your keyboard to remove it.

13. Select the range A3:A12 using an alternative keyboard technique: Click cell A3 to select 
it, then release your mouse button; then hold down your Shift key and press the ↓ key one 
time to add cell A4 to the selection. Continue holding Shift and tapping ↓ to select cells 
A5:A12. Then delete this range as well. The 1st Qtr Sales sheet should now be empty.

Yet another way to select a range is to click the first cell, then Shift+click the last cell. Try 
it. Undo the last deletion you did, then click cell A3; hold down Shift and click cell A12. 
You’ll see that this selects the whole range. Delete the range again.

14. Use the Save As command to save this file in your Chapter One folder, and name it Exer-

cise 1-17.xls. Leave the file open for the next exercise.

E X E R C I S E  1 . 1 8  

Selecting Noncontiguous Ranges

1. In the March Sales sheet, select the range A3:A11. (Remember that you cut the data from 
row 12 in Exercise 1.17, so that row should be empty.)

2. With A3:A11 selected, hold down your Ctrl key, click cell B3, and drag the white plus sign 
over to cell E3 to add that to your selection. Note that B3 does not appear to be high-
lighted but B3 shows in the Name box, so that assures you that it is included in the selection.

E X E R C I S E  1 . 1 7 ( c o n t i n u e d )
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3. Now try to copy that selection. You see this error message:

4. Click OK to clear the message. 

5. You cannot copy noncontiguous selections. Try to cut it instead. You see this similar 
message:

6. Click OK to clear the message.

7. With the noncontiguous range selected, press Delete on your keyboard and the cells will 
be cleared.

8. Click the Undo button to bring the deleted data back.

9. Try another noncontiguous selection:

a. Select the range A3:E4.

b. Holding down your Ctrl key, click cell B6.

c. Still holding the Ctrl key, select the range C7:D11.

Here’s how your selection should look:

E X E R C I S E  1 . 1 8 ( c o n t i n u e d )
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Using the Office Clipboard

The Windows Clipboard is rather limited; it holds only the last item you cut or copied. As soon 
as you cut or copy something new, the previous item is overwritten. However, Excel allows 
you to use the Office Clipboard, which can hold up to 24 blocks of data at one time. This lets you 
make multiple cuts and copies before you paste any of them, and then you can choose what 
you want to paste, and where you want to paste it. This is the way to override Excel’s behavior 
of not allowing you to cut or copy noncontiguous selections. Exercise 1.19 shows you how.

10. To deselect the selection, simply click in any cell that is not part of the selection.

11. Close the file and click Yes when Excel asks if you want to save it. This will overwrite the 
previous copy.

E X E R C I S E  1 . 1 9  

Pasting Multiple Cut and Copied Blocks of Data

1. Open the file Exercise 1-18.xls that you saved in the last exercise. (If you did not save it, 
extract it from the zipped file for this chapter.)

2. Select Edit � Office Clipboard.

3. The Office Clipboard task pane appears. It should be empty, as shown here. If it is not 
empty, click the Clear All button near the top.

E X E R C I S E  1 . 1 8 ( c o n t i n u e d )
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4. Move to the January Sales sheet. Use one of the methods you learned earlier to get into 
Edit mode in cell A1 and change the content of the cell to read January Monthly Sales 
Report.

Reminder: To get into Edit mode in a cell, do one of the following:

� Double-click the cell.

� Click the cell and press F2.

� Click the cell; then click in the Formula bar.

5. Still in Edit mode, using the I beam, drag across the text “Monthly Sales Report” to select 
all the text except the word January. Copy it and it will appear on your Office Clipboard.

6. Move to the March Sales sheet, select the range A3:A11, and copy it. It also appears on 
the task pane.

7. Next, select B3:E3 and copy that range.

8. Now, select B11:E11 and cut that range. Then select A11 and press Delete. 

9. You now have four different blocks of data on your Office Clipboard. Move to the Febru-
ary Sales sheet.

10. Get into Edit mode in cell A1 and select just the word Sales, not the word February.

11. With the word Sales selected, click the task-pane text that reads “Monthly Sales Report.” 
Notice that the text is pasted over what you had selected, so cell A1 now says “February 
Monthly Sales Report.”

12. Go to the March Sales sheet and repeat step 11 to change cell A1 to “March Monthly 
Sales Report.”

13. Go to the April Sales sheet and type the word April in cell A1; press your spacebar one 
time; then click the text “Monthly Sales Report” in the task pane. Cell A1 now shows 
“April Monthly Sales Report.”

14. Follow the previous procedure to put the appropriate month, followed by a space, fol-
lowed by the text “Monthly Sales Report” into the May through December Sales sheets 
(not in the Qtr Sales sheets nor the Yearly Totals sheet).

E X E R C I S E  1 . 1 9 ( c o n t i n u e d )
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Using the Mouse to Drag and Drop or Fill Data

Up to this point, you have used three different mouse pointers (the white plus sign, the row/
column resizing pointer, and the I beam), but Excel has more and you must understand them 
in order to use them correctly to perform the action you intend. The ones we will use for this 
exercise are pictured in Figure 1.9.
� The white plus sign is used only for selecting cells and ranges.
� The black four-headed arrow is used to drag and drop cells and ranges.
� The black plus sign is seen only if your mouse hovers over the fill handle on a cell. The fill 

handle is the small black box you see in the lower-right corner of any selected cell or 
range, as shown here. This pointer is used to copy data or fill a series.

15. Once you have completed all of the monthly sales sheets, move your mouse over the task-
pane text that reads “Monthly Sales Report.” You will see a dropdown arrow to the right of 
the text. Click this arrow and choose Delete to remove this item from the Office Clipboard.

16. Move to the 1st Qtr Sales sheet and click cell A3. Click the list of store names in the task 
pane to paste them into cells A3:A11.

17. Click the April Sales sheet. Click cell A3 and paste the store names.

18. Click cell B3 and paste the week titles (Week 1, Week 2, etc.).

When using the Office Clipboard, your column widths do not come through; choosing Paste 
Special gives you different choices, and you cannot choose to paste the column widths. You 
will have to use one of the other methods you learned to adjust the column widths.

19. Click cell B11 and paste the numbers for the Flora store.

20. Click the Clear All button at the top of the task pane to remove all of the items from the 
Office Clipboard.

21. Use the Save As command to save the file in your Chapter One folder and name it Exer-

cise 1-19.xls. Close the file and close Excel.

E X E R C I S E  1 . 1 9 ( c o n t i n u e d )
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F I G U R E 1 . 9 Mouse pointers can make a big difference in Excel.

It’s definitely easier to understand these pointers in action, so you’ll get a chance to practice 
using them in Exercise 1.20. 

E X E R C I S E  1 . 2 0  

Using the Different Mouse Pointers to Select, Move, and Copy Data

1. Open Excel with a new blank workbook showing.

2. In cell A1, enter the number 100 and press Enter.

3. Click cell A1 and copy it.

4. Select the range A2:B10, using the white plus sign pointer, and paste. Note that you can 
paste the same data into multiple cells if you select the range before you paste.

5. Use the Ctrl key with the white plus sign to select cells C1, C3, and C10, and paste again. 
Note that you can paste into noncontiguous cells as well. Notice the marquee remains 
around cell A1 because the content of A1 is still on the Clipboard and you can continue 
to paste it as many times as you want until it is cleared from the Clipboard.

6. Press your Esc key to remove the marquee and clear the Clipboard.

7. Select cell A1 and type 200, then press Enter.

Black Plus Sign

White Plus Sign

Black Four-Headed Arrow
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8. Select cell A1 again and, without holding the mouse button down, move your pointer 
over cell Al’s edge until you see the black four-headed arrow. Click with this pointer and 
drag the cell over to cell F7. As you drag, the pointer changes to a white diagonal arrow 
and a tooltip shows the cell name you are over. When the tooltip shows F7 (see the fol-
lowing graphic), release your mouse button. The number 200 has been moved from A1 
to F7.

9. Using the black four-headed arrow again, drag cell F7 until it is over cell F2, but this time 
hold the Ctrl key down while you drag. Notice the small plus sign attached to the white 
arrow. The plus sign tells you that you are copying the cell instead of moving it.

10. Select the range A2:B4, use the black four-headed arrow to drag it to the range D6:E8, and 
drop it. Note that the tooltip shows the range that will be filled instead of just one cell 
name. 

11. Select the range D6:E8 and Ctrl+drag it to the range A2:B4 and drop a copy of it there.

12. Edit cell A2 so the value is 300 and press Enter. Select A2 again and hover your mouse 
pointer over the fill handle of that cell, in the lower-right corner, until you see the black 
plus sign.

13. Click with the black plus sign and drag the number 300 down to cell A10. Notice that it 
copies 300 to every cell you pass over on your way to A10.

14. You’ll notice the Options button that appears to the lower right of cell A10. Click it to see the 
Auto Fill options, such as Copy Cells, Fill Without Formatting, and so forth, as shown here:

15. The default option, when you drag using the fill handle, is to simply copy the cells. 
Choose Fill Series, and the numbers will progress in a series from 300 to 308.

E X E R C I S E  1 . 2 0 ( c o n t i n u e d )
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There are many ways to use Auto Fill, and more of them are explained in 
Chapter 4, “Editing Tools, Comments, and Hyperlinks.”

Summary
Understanding how to easily move around a workbook and quickly move to any given section 
is imperative for the most effective use of the program. Knowing which menu houses which 
command will also speed up your process, with less trial-and-error guesswork. Commands 
can be executed in Excel by choosing a command from a menu, choosing a command from the 
task pane, right-clicking and selecting a command from a shortcut menu, using the various 
toolbar buttons, or using keyboard shortcuts.

An Excel file is called a workbook; workbooks can include many worksheets. You can nav-
igate through a workbook, from sheet to sheet, and navigate through a worksheet, from cell 
to cell. Or you can use methods to move to specific content from anywhere in the workbook.

You can add data and edit data, add new worksheets and edit sheet names, and add and 
remove cells, columns, and rows. You can also manage the size of your rows and columns.

Excel helps you manage your files and folders by using the Save As dialog box to name files, 
create new folders, choose the location where you want the file saved, and specify the file type.

After data is entered in a worksheet, you can move it or copy it to another location on the 
sheet, or to another sheet. Moving and copying can be done by using the cut, copy, and paste 
commands or by using the mouse to drag and drop or fill.

You can select parts of the content of any cell, or the entire cell, or entire ranges, either 
contiguous or noncontiguous. Once selected, the selection can be moved, copied, or deleted 
in one step.

16. Select cells A9 and A10, which now contain 307 and 308. Now use the black plus sign on 
the fill handle on A10 to drag both cells down to A15. When you select multiple cells, 
Excel recognizes the series and fills the series by default.

17. Click the Options button and choose Copy Cells. Now instead of filling the series, Excel 
just copies 307 and 308 over and over.

18. Continue to explore different ways to use the different mouse pointers to move, copy, 
and fill data. When you are done, close the file and close Excel. You do not need to save 
this one.
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Exam Essentials
Know the terminology. Get familiar with the terms used in Excel so the MOS scenarios 
make sense to you. Remember to use tooltips to identify the names of everything onscreen.

Learn the quickest way to do everything. Try all the methods for moving around the work-
sheets and find the ones that work best for you. Get familiar with where everything is located. 
The MOS Exam is a timed exam, so know how to use the shortcuts like Go To and Find.

Be sure you understand the difference between deleting content and deleting cells. Under-
stand how to delete content, as well as cells, rows, columns, ranges, and sheets. Also, know 
how to insert rows, columns, and cut cells.

Be able to move and copy data, cells, ranges, and sheets. Know the difference between 
move (cut and paste) and copy (copy and paste), and understand all the ways to select contig-
uous and noncontiguous data and use the Office Clipboard.

Understand the cell modes and mouse pointers. Be aware of what mode (Ready, Enter, and 
Edit) you are in when working in cells, and be sure you know which mouse pointer does what.

Be able to modify row and column formats. Know how to resize rows and columns, using 
both the mouse pointer and the Format menu.

Know how use the Save As dialog box. Understand how to create folders in the correct 
locations, how to save files into the correct folders, and how to choose the correct file type.

Sample MOS Scenarios
The following scenarios simulate the types of exercises you will encounter while taking your 
MOS Exam. Complete these scenarios, which focus on the MOS objectives covered in this 
chapter; then check the solutions to see how you did. To complete these exercises, you will 
need to extract the file MOS Scenarios Ch 1.xls from the zipped file for this chapter. Open the 
file in Excel before you begin the scenario exercises.

 

MOS Scenario 1: Enter and Edit Cell Content and Manage Columns and Rows

Change the store names in column A, beginning with A4, to Bayberry Shops; Wilson Appli-

ances; The French Corner; Riley & Sons, Inc.; Madison Avenue; The O’Leary Bros.; and Rose-

wood Plaza. Change the dollar amounts for the Madison Avenue row so that they are all 
exactly 100 dollars higher. Add a row above The O’Leary Bros. row and enter the shop name 
Smithfield Clothiers, with sales for each week that are the same as the sales for Wilson Appli-
ances. Adjust all columns so they fit the longest data in the column.
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MOS Scenario 2: Add Worksheets and Find Data

Rename the worksheet to March 2005, then add two more sheets and name them March 2004 
and March 2003. Rearrange the sheets so they are in chronological order and make each tab 
a different color. Copy all of the data from the March 2005 sheet and paste it into both of the 
other sheets. Find all occurrences of The French Corner and change them to The French Riviera 
on all three sheets. Make sure all column widths are adjusted appropriately.

 

MOS Scenario 3: Insert, Move, and Delete Cells and Save Files

On the March 2005 sheet, delete row 2 and change the height of the new row 2 to 20 points. On 
the March 2004 sheet, insert a cell above C9 so that the value in C9 moves down to C10. Cut the 
value in C12 and paste it into C11. Save the file into the My Documents folder inside a new 
folder you create called MOS Scenarios. Name the file ChapterOneScenarios.xls. Move to the 
March 2005 sheet and save the file as a text (tab-delimited) file in the same location with the 
name ChapterOneScenarios.txt. 
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